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Chapter Overview
NCSA Telnet allows you to customize the environment to suit your special needs and
habits. This chapter covers some more advanced aspects of the NCSA Telnet 
working environment. It describes how to change the configuration settings, set the 
characteristics of session windows, and customize other NCSA Telnet operations 
using the Preferences dialog box and the Session menu.

Using the Configuration Dialog Box
NCSA Telnet allows you to specify certain configuration characteristics from within 
the application, right before you open a particular connection. For example, you can 
change the window name for a connection, set the function of the BACKSPACE (or 
DELETE) key, and specify whether Tektronix graphic images are displayed in 
separate windows.

To configure a telnet session:

1. Choose Open Connection from the File menu or press ⌘-O. The Connection dialog 
box shown in Figure 3.1 appears.

2. Specify a session name.

3. Click Configure. The Configuration dialog box appears 
(Figure 3.2).

Figure 3.1Connection Dialog Box
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Figure 3.2Configuration Dialog Box

Window Name
The session name serves as the window name and appears in the session window's 
title bar, unless you designate a different window name. To designate a window 
name, enter the desired name in the Window Name box. (You may also specify the 
window name by entering the name in the Window Name box of the Connection 
dialog box.)

Columns
A session window may contain either 80 or 132 columns. Specify the number of 
columns to be displayed in your session window by clicking the appropriate radio 
button in the row labeled Columns.

For information regarding changing the number of lines displayed in a session 
window, see the section of this chapter entitled "Set Usable Lines."

NOTE:  When you specify 132 columns, you may not be able to see all of the 
columns in a session window at one time. You can resize the session window and 
use the horizontal scrollbar to view obstructed columns.
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Backspace Is
The BACKSPACE (or DELETE) key may be used to send backspace or delete codes. To
assign the function you prefer to this key, select either Backspace or Delete in the 
row labeled Backspace Is. For more information regarding the BACKSPACE (or 
DELETE) key, see "Setting the Functions of BACKSPACE (or DELETE), OPTION, and 
Backquote" in Chapter 2.

Tek Clear Screen
The default setting for this option is Clears Screen. The Tek Clear Screen setting 
applies while you are operating in the Tektronix drawing mode. By default, when a 
clear screen code is received and you generate a new image, the screen is cleared; 
that is, any drawing on the screen is overwritten with a new image.

If you change the default by selecting the Creates Window option, and then 
generate a new image, a new window is created for the image and the contents of 
the active screen are not overwritten. Each new screen created in this way has as its
name the session name and time. For more information regarding Tektronix drawing 
mode and the clear screen code, refer to Chapter 6, "Tektronix 4014 and 4105 
Emulation."

Return Sends
This option allows you to change the type of end-of-line marker sent by the 
Macintosh and establish compatibility with some 4.3 BSD UNIX systems. The default 
for this option is CRLF. When CRLF is active, NCSA Telnet sends a carriage return 
followed by a line feed. Select CR-NUL to instruct NCSA Telnet to send a carriage 
return followed by NUL, if that is needed by your host.

Echo Mode
You can set NCSA Telnet to operate in either of two echo modes:  local or remote. In 
local echo mode, characters are copied to the screen immediately as you type 
them. In remote echo mode, the characters are sent to the host, which sends them 
back to be printed. The Echo Mode option only applies when you are operating in 
local echo mode.

To enter local echo mode, also known as line mode, enable the Local Echo option in 
the Session menu. The menu item appears checked when local echo mode is active.

You can use the Echo Mode option in the Configuration dialog box to configure Local 
echo mode to work in either of two ways:  the characters you type can be buffered 
locally and sent when you press RETURN, or they can be sent immediately as you 
type. To specify the former, select the Buffers option in the Configuration dialog box.
To specify that each character be sent immediately as you type it—a process known 
as half duplex—select Sends.
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NOTE:  Keystrokes that include control characters, including tab and return, are 
always sent immediately as they are typed.  Some hosts force local echo mode 
automatically. If local echo mode is not forced by your host, you may still want to 
enable it to improve keyboard response time. Local echo mode should be used 
carefully, because it is incompatible with most full-screen editors.

TEK Mode
You can specify the default TEK emulation type, either 4014 , 4105, or none. with 
this control. If you select "none," then Telnet will not allow TEK displays on screen. 
Your system administrator can also set the initial value within the configuration 
file.To do this, see chapter 8, "System Administrator Information." After you open a 
session, The specified TEK Mode becomes the default.

Scrollback
Check the box labeled Scrollback to activate the scrollback feature.

To change the number of lines that NCSA Telnet saves and allows you to view by 
scrolling, type the desired integer in the text box. The default is usually 200 lines, 
although this may have been changed by your system administrator in the 
configuration file. If you reset the number of scrollback lines and then save this 
configuration using Save Set, the setting is saved as part of that set (see "Saving 
Session Characteristics" in Chapter 4).

NOTE:  The scrollback feature gradually consumes memory for the number of 
scrollback lines that you specify, so be sure to watch your memory consumption if 
you specify a high number of scrollback lines.

Linemode
NCSA Telnet supports the Telnet Linemode Option, developed by the Internet 
Engineering Task Force-Telnet Linemode Working Group, and which is being 
implemented by Cray. In previous versions of NCSA Telnet, the program would send 
out data one character at a time, which resulted in a large amount of network 
overhead for large multi-user systems.  

Now when you enable the linemode option, NCSA Telnet sends data to the host 
machine a line at a time rather than a character at a time, thus greatly reducing 
network traffic.

NOTE:  Even if linemode is set for enable, NCSA Telnet can only use linemode if the 
host machine supports it.  Therefore, the use of the linemode feature is ultimately 
decided by the connected host's capabilities.
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Eight Bit Font
Telnet now has the ability to pass through characters with the high-bit set. If you 
choose the Eightbit option, visible characters with the high bit set will be handled 
properly. If not, Telnet strips the high bit off of such charaters, as it did in all previous
versions.  

Using the Preferences Dialog Box
The options contained in the Preferences dialog box are described in the following 
sections.

To use the Preferences dialog box:

1. Select Preferences from the Edit menu. The Preferences dialog box that appears 
contains a check box for each option available. The Preferences dialog box is 
shown in Figure 3.3.

2. Specify a Copy Table Threshold by clicking within its box and entering the desired 
number by typing on your keyboard.

3. Select or deselect an option by clicking the box that appears before it. The box 
becomes checked or unchecked to indicate that the option is activated or 
deactivated, respectively.

4. Click OK or press RETURN to apply the selected options. Click Save to save the 
specifications as the default, so that next time you invoke NCSA Telnet, these 
options are activated automatically. Click Cancel to undo any changes you have 
made. When you click one of these buttons or press RETURN, you are returned to 
the application.
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Figure 3.3Preferences Dialog Box

Copy Table Threshold
The Copy Table Threshold value determines the number of spaces which, at a 
minimum, are replaced by tabs when you issue the Copy Table command from the 
Edit menu or press ⌘-T. Instead of using the standard Copy command, you can use 
the Copy Table command to copy tables of data from the NCSA Telnet screen onto 
the Clipboard.

When you use the Copy Table command, all strings of contiguous spaces that are 
greater than the threshold are turned into tabs before being placed on the 
Clipboard. This produces a format that can be pasted into most spreadsheets and 
graphing programs without losing data or requiring additional formatting.

Command Keys
By checking the Command keys option in the Preferences dialog box, you obtain 
access to command key equivalents for commands listed in the individual menus. 
This option also determines whether the ⌘-key functions as the CONTROL key. When
the Command keys option is checked, the command key equivalents are listed 
beside their corresponding items in the menus and ⌘ does not translate to 
CONTROL. For more information regarding command keys, see "Using Keyboard 
Commands" in Chapter 2.
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Remap Option Key to Control
Select Remap option key to control if you want the OPTION key to substitute for the 
CONTROL key. This option is most useful on machines such as the Macintosh Plus, 
which has no control key of its own.  However, it is not available under Operating 
System 7.

NOTE:  If you are working on a Macintosh Plus and want to use the Command keys 
option, you should only do so in conjunction with the Remap option key to control 
option; otherwise, you will not be able to generate control characters.

For more information regarding changing the function of the OPTION key, see 
"Setting the Functions of BACKSPACE (or DELETE), OPTION, and Backquote" in 
Chapter 2.

Remap Backquote to ESCape
Select Remap backquote to ESCape when you want to use the Backquote key as the
ESC key. When this option is checked, pressing the Backquote key, sends an ASCII 
ESC character. For more information regarding this option, refer to "Setting the 
Functions of BACKSPACE (or DELETE), OPTION, and Backquote" in Chapter 2.

MacBinary
The MacBinary option controls the default setting for the MacBinary Enabled option 
in the File menu. When this option is checked, the MacBinary Enabled option (and 
consequently MacBinary mode) are activated by default when the application is 
started. See Chapter 5, "File Transfer," for more information on MacBinary mode.

Reset MacBinary for Each FTP
The Reset MacBinary for each FTP option controls whether the MacBinary mode 
setting is to be returned to its default state upon the initiation of an FTP session. The
default state of MacBinary is whatever you last set for the MacBinary option (see the
preceding section,"MacBinary").

NOTE:  "Each FTP" corresponds to establishing the FTP command connection and 
not the individual file transfer.

Windows Don't Go Away on Close
Select Windows don't go away on close if you want the session window to be 
displayed on the screen even when its associated connection has been terminated.

This feature allows you to read, copy, and print text that is in a window whose 
connection has been closed. To close such a window, click in its close box.
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Staggered Windows
When you've selected the Staggered Windows option, the program staggers 
multiple windows by a whole title bar, allowing you to see each window's title. 
Otherwise, NCSA Telnet only staggers the windows by a few pixels.

System KCHR
Telnet 2.5 has the ability to map characters from the System KCHR resource instead 
of KCHR built into Telnet. This allows users to have all the keys mapped by the 
system, instead of each particular application. If this feature is desired, select this 
option.  

Blink Cursor
Click the "Blink Cursor" button if you want the cursor to blink during a Telnet 
session.

Cursor Selection
You can now select what kind of cursor Telnet uses for text display. Click the 
appropriate button to choose either a block cursor, underscore cursor, or vertical 
bar cursor. See figure 3.4 for an example of each cursor type.

Figure 3.4Cursor Typos

Using the Session Menu
The items in the session menu, depicted in Figure 3.5, are described in the following 
sections.  For more information, however, you may want to refer to chapter 4, 
"Advanced Features."

Customizing the Environment 3.11



Figure 3.5Session Menu

Backspace
Enable the Backspace option to set the function for the BACKSPACE (or DELETE) key 
to backspace. When you enable the Backspace option, the option appears checked 
in the menu. For more information, see "Setting the Functions of BACKSPACE (or 
DELETE), OPTION, and Backquote" in Chapter 2.

Delete
Enable the Delete option to set the function for the BACKSPACE (or DELETE) key to 
delete. When you enable the Delete option, the option appears checked in the 
menu. For more information, see "Setting the Functions of BACKSPACE (or DELETE), 
OPTION, and Backquote" in Chapter 2.

Local Echo
Enable the Local Echo option to enter local echo mode, which is described in this 
chapter's section,"Echo Mode." When you enable the Local echo mode, the option 
appears checked in the menu.

Wrap Mode
Enable the Wrap Mode option to activate wrap mode. In NCSA Telnet, wrap mode 
controls the status of the wrap setting. When you enable the Wrap Mode option, it 
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appears checked in the menu.
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The VT102 terminal maintains an internal setting to determine whether characters 
printed off the right hand side of the screen cause the terminal to wrap or not. If you
set the terminal to wrap, the new characters appear on the next line of the screen 
and the screen is scrolled if necessary. If you disable wrap mode, each new 
character replaces the last character on the current line and the cursor neither 
moves right nor onto the next line.
You may also set the wrap mode in the configuration file (see Chapter 8 for details). 
Whenever you select the Reset Terminal command in the Session menu, wrap mode 
is disabled.

NOTE:  Host software commonly sets the wrap mode, overriding this setting.

Clear Screen Saves Lines
This option toggles between saving lines and erasing lines when the clear screen 
code is received. If you check the option, all lines currently displayed on the screen 
are scrolled into the scrollback region before the screen is cleared. If you do not 
check it, the cleared lines are permanently disposed when the screen is cleared.

Reset Terminal
Select Reset Terminal to reset the VT102 screen, for example, when a host program 
accidentally sets graphics mode or fails to leave graphics mode. The Reset Terminal 
command resets all VT102 mode settings—disabling wrap mode, resetting graphics 
mode, resetting the keypad mode to the default, and resetting tabs to every eight 
spaces.

Jump Scroll
Select Jump Scroll to skip to the end of the local buffer.

The Jump Scroll option causes the screen to pause and then jump ahead over 
scrolling text. The text is placed into scrollback, but the screen update advances to 
the end of the local network buffer instead of printing every line on the screen.

The purpose of this feature is to save time. For example, when you enter a 
command that produces a great deal of output, you can use Jump Scroll to avoid 
waiting for the output to scroll by.

TEK Page
Select TEK Page to quickly create or clear a Tektronix emulation window without 
requiring intervention from host software.

Normally the emulation window appears automatically when the clear screen 
command sequence is received from the host. But the TEK Page command creates 
the window immediately. To clear 
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the current session window, use the TEK Page command the same way you would 
use the Page key on a real Tektronix terminal. For more information regarding the 
clear screen command and Tektronix emulation, refer to Chapter 4, "Advanced 
Features."

TEK Form Feed Clears Screen
Another new feature in Telnet 2.5 is the ability to supress Telnet from clearing the 
screen during TEK emulation. Often TEK images include a form-feed command at 
the end of them, and that causes the TEK screen to be immediately cleared upon 
reaching the end of the image. However, this makes it hard to see the final image of
the TEK file. 

Therefore you can now set this option to false, in which case Telnet will not clear the
TEK window when it encounters a form-feed command. If this option is set to true, 
then Telnet acts just as it normally would.

Set Usable Lines
Select this option to increase or decrease the number of lines displayed per screen 
in a session window.

NCSA Telnet session windows initially display 24 lines per screen by default, because
the actual VT102 terminal screen has room for exactly 24 lines of text. Some host 
systems, allow you to define a VT102-like terminal type which has more or fewer 
than 24 lines.

To increase or decrease the number of lines displayed per screen in a session 
window:

1. Select Set Usable Lines from the Session menu. The Set Lines dialog box appears,
showing the current number of lines displayed (Figure 3.6).

2. Enter a value from 10 to 200 to specify the desired number of lines.

3. Click OK or press RETURN to return to your session window or click Cancel to 
abort the change.

After you change the number of lines for a screen, the size of the window changes 
to accommodate the new number of lines.
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Figure 3.6Set Lines Dialog Box

Shortcut
To quickly change the number of lines displayed per screen in a session window, 
hold down OPTION while adjusting the size of the window using the size box. As the 
window changes size, NCSA Telnet recalculates the number of lines in the window. 
When you release the mouse button, the number of usable lines in the window 
exactly fills the window. This method is equivalent to using the Set Usable Lines 
command.

WARNING:  If you do not have a good working knowledge of how your host system 
makes us of terminals with greater than 24 lines, you are recommended to use only 
24-line windows. The following warnings and suggestions assume knowledge of 
UNIX-based software to control the number of lines for the terminal. Consult your 
host system documentation or system administrator for more information.

Warnings and Suggestions
The termcap file, (found in UNIX systems only), is commonly located in 
/etc/termcap, and can be set up to include the number of lines on the terminal. 
The default VT100 termcap includes an explicit setting of 24 lines, so even if you 
enlarge your NCSA Telnet window, the host uses only the top 24 lines. You can 
create special termcap entries by editing the /etc/termcap file. Copy the VT100 
entry to a new name and change the number of lines to your preferred screen size.

Berkeley UNIX-based systems have a special feature in the stty program. The 
number of rows in a session window can be set to any value, and applications 
programs such as vi learn your window size from the stty setting. The following 
command line sets the window size to 33 lines.

stty rows 33
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Using the special macro variable #, you can create a macro that issues this 
command and automatically substitutes the number of lines for the current window. 
For example, you could define the macro for ⌘-0 as the following.

stty rows \#

Now, you can set the window size by pressing ⌘-0 and then RETURN. The 
sequence \# is replaced with the proper number of lines.

See "Defining Macros" in Chapter 2 for information about creating and saving 
macros.

NAWS
Telnet 2.5 features "Negotiations About Window Size," or NAWS. Some UNIX hosts 
allow the client to send information regarding the Telnet user's window size. 
Consequently, when the user changes the number of useable lines by using the "Set
Usable Lines" dialog box, this new information is sent over the network to the host. 
In this case, the user does not need to use the stty rows operation. The host knows 
how big the window is, which straightens out a lot of problems for screen-oriented 
applications such as vi. NOTE: this feature is not present on all UNIX machines. If the
host does allow NAWS, then Telnet handles this feature automatically -- the user 
does NOT need to do anything extra.

Setup Keys
Select Setup Keys to select which keys issue the telnet commands Interrupt, 
Suspend, and Resume (see "Changing the Assigned Keys for Interrupt, Suspend, and
Resume" in Chapter 2.)

Font
The submenu contained under the Font command contains the fonts that you may 
use to display text in a session window. When you select a font from this submenu, 
the current window is resized to contain the text and the selected font is used to 
display all text in the current window.

NOTE:  Fonts which are proportionally spaced (most fonts except Courier and 
Monaco) display slowly and appear spread out.
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Size
This option allows you to change the size of text in the current window. The 
submenu contained under the Size command contains the point sizes that you may 
use to display text in a session window. The submenu lists all available sizes, 
displays a check-mark next to the current size, and outlines all sizes present in your 
system. When you select a size from this submenu, the current window is resized to 
contain all the resized text and the text is redrawn according to be the specified 
point size.

NOTE:  Sizes which do not appear outlined in the menu must be scaled by the 
system software and therefore may be slow and not as sharply defined as the non-
scaled sizes.

Color
The color option only applies to Macintoshes that are color-equipped. Select Color to
change the foreground and background colors of the current window for both normal
text and blinking text. The Color Selection dialog box appears (Figure 3.7).

To assign a color to text or the background of a session window:

1. Click the box next to the item to which you wish to assign a color:  Normal Text, 
Normal Background, Blinking Text, or Blinking Background. Click OK, or double-
click the appropriate box to call up the Color Wheel dialog box, shown in 
Figure 3.8.

2. Select a new color by clicking in the color wheel. The color you select appears in 
the top rectangle under the heading Choose a color.

3. Click OK or press RETURN to enable the color change and return to the Color 
Selection dialog box. The box next to the item you selected in Step 1 reflects the 
color you chose from the Color Wheel dialog box.

4. Repeat Steps 1 through 4 to assign colors to other items in the Color Selection 
dialog box.

5. Click OK when you have finished choosing colors. The colors you selected are 
applied to your current session window.

For additional information on using the color wheel dialog box, refer to your 
Macintosh System Software User's Guide.
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Figure 3.7Color Selection Dialog Box

Figure  3.8 Color Wheel Dialog Box

Choose a color:

Switch to SLIP
This option allows Telnet to use SLIP for serial connections.  For more information 
about SLIP and serial connections, please see chapter 9, "Serial Communications." 
Note this item only effects connections that are through the serial port.

Switch to Serial
When this option is selected, Telnet will use normal serial connections instead of 
SLIP.  Once again, this option is strictly for serial connections, and does not effect 
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normal telnet connections.
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Capture Session to File
Telnet 2.5 has the new feature of being able to save text from a session to a file. When this option is selected, all 
normal text output that appears on the screen will also be saved to a file that the user can specify. This 
functionality turns on when the user selects this menu item, and turns off when the user deselects the menu 
item. As is standard with Telnet, a check will appear in the menu when this option is selected, to inform the user 
that the text from that session is being captured. For information on how to change the name of the capture file, 
please see chapter 4 under the heading "Network-Related Commands:  Configure Network."
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